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Support Information

This manual supports Vita-Mix® Custom Blending Software v 2.0.
For the most up-to-date detailed instructions, go to:
www.vitamix.com/foodservice/products/instruction_manuals
and go to the Blending Programmer section.

For additional information, please contact:

VITA-MIX® CORPORATION
Foodservice Division

8615 Usher Road

Cleveland, Ohio 44138-2103 USA
www.vitamix.com/foodservice

In the U.S., Canada and Latin America

Toll Free: 800-4DRINK4 (800-437-4654)

Phone: 440-235-0214

Fax: 440-235-9670

E-mail: PBSService@vitamix.com or foodservice@vitamix.com

All other countries:

Contact your local Vita-Mix distributor or contact Vita-Mix International at
Tel.: +1.440.782.2450

Fax: +1.440.782.2220

Email: international@vitamix.com
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Overview

Vita-Mix® Custom Blending Software facilitates fast, easy
programming of the following via PC or laptop:

« Vita-Mix PBS Portion Blending Systems®

* Vita-Mix PBS Ho0°

« Vita-Mix Blending Stations®

+ Vita-Mix BarBoss® Advance and Drink Machine Advance
« Vita-Mix Mix’n Machine™ Advance

+ Programmer Chips used with both of the above units

System Requirements

Operating System

Microsoft Windows Server 2003 (32-Bit)
Windows XP Professional (32-bit)

Windows XP Home Edition

Windows 2000

Windows Millennium Edition (Windows Me)
Windows 98*

Microsoft Windows NT 4.0 Service Pack 6a*

*Requires Internet Explorer V5.01 or higher. USB support may not be available

Processor
Required: 450 MHz, Recommended: 600 MHz or higher

Memory
Required: 64 MB, Recommended: 256 MB or higher

Hard Disk
Required: 40 MB, Recommended: 200 MB or higher

Interface
Required: USB

Monitor
Required: Super VGA (1024x768) or higher resolution display with 256 colors
Recommended: Super VGA (1024x768) or higher resolution display with 32-bit color

IMPORTANT!
Monitor resolution on the host computer should be at the default setting.
Alternate settings may cause the program to display incorrectly.

Windows is registered trademarks of the Microsoft Corporation.
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Before Using the Program

1. Vita-Mix® Custom Blending Software must be installed on the host computer
before use. See Appendix A: Installing the Software for complete installation
instructions.

2. The Vita-Mix Programmer Module must be connected to a USB port on the
host computer before use. See Appendix B: Working with the
Programmer Module for complete instructions.
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Getting to Know the Program

Vita-Mix® Custom Blending Software is powerful, yet exceptionally easy to use.
Please take a few moments now to read the following overview of the available
features and functions. If you have not already installed the program, please see
Appendix A: Installing the Software.

1. Open Vita-Mix® Custom Blending Software using either of the following two
methods:

- Double-click on the Vita-Mix Programmer shortcut icon, shown
at right. The shortcut is located on the Windows desktop.

- Open the program via the Windows Program Menu.

2. If the Programmer Module is not connected to the host computer, or if the
Programmer Module is improperly connected, the following message will be
displayed:

Mo Programmer Detec 5'

& Mo Programmer Detected

3. Click OK, then check all hardware connections (see Appendix B: Working
with the Programmer Module).

4. If the Programmer Module is properly connected and configured, the
Programmer window will be displayed:

. .
vua.nlx BLENDING PROGRAMMER
= )

6 © Vita-Mix Corporation — Getting to Know the Program



5. Select a blender type to program.

Click on the desired blender type to open the Programmer Window. New
Advance machines are listed on the right side of the Blending
Programmer selection screen.

NOTE: If you are programming a Portion Blending System® with built-in water
dispenser (PBS H,0), select With Water Support before clicking on Portion
Blending System.

S ] ]
EVItﬂ.M'x BLENDING PROGRAMMER
= o

Select a blender to program
Portion Blending System Blending Station

——
i f2 3

© 2004 Vita-Mix® Corporation

PBS Water Support option Blender selections
Click on the box to activate the selection.  Click to select desired blender type.
Activation is indicated by a checkmark.

6. After the desired blender type has been selected, the Programmer Window
will open.
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Programmer Window
Portion Blending System® and PBS Advance (Water Support not selected)

[Mveava-bos . =101}

Fis e Modde el

I i Salsct the desited Titke for the program,  (Title wil display on unit)
' VIN'HIK b B rosram titte ing 1) [THE E=5T2 U T

fine 2) [SMOCTHIE #1

2P i st pogan. @)(2)(3)(3)(A)8) AT

L2 ..J. A .'.,
&8 Solectthe desired mount of e and water 68 portions ¢
\

1o dispense. (0 min. - 70 units max |

Vitaix Corp. © 2004
'STATUS Madule Connpcid

PRE BLEND power setting Ice portion setting

Filanome - delaul FO5.

Programming Steps

The Programmer Windows for Portion Blending System and PBS Advance (Water
Support not selected) include options for programming the desired ice portion and
a power setting for a PRE BLEND segment of the blending cycle.

Programming Steps include:

&P Enter a program title.

&P Click on a button to program (1-4, A-B).

&P Enter the desired ice portion
(portion units are approx. 0.5 0z. /14.7 ml).

&P Enter a button title, then edit the power setting for the PRE BLEND segment.
Next, edit time, ramp and power settings for blending segments A-D (it is not
necessary to use all available segments).

€P Select a final programming operation.
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Programmer Window
Portion Blending System® H,0 (Water Support selected)

Wil Mo RS o 2

Fle Vi Moo Hep

[ RTAPHETIS Select the desired Title for the program.  (Title will display on unit )
l vnu'““ B program title flos 1) |THE EEST AU B

082 [SMOOTHEE #1 —

STATUS - Madule Cannected, Filenams : defach PES
/7

Ice and Water Support Options

Programming Steps

The Programmer Window for Portion Blending System® H.0 (Water Support
selected) includes options for programming the desired ice portion, water portion
and a power setting for a PRE BLEND segment of the blending cycle.

Toial Time -0 secon -

Programming Steps include:
&P Enter a program title.

@D Click on a button to program (1-4, A-B).

&P Enter desired ice and water portions
(portion units are approx. 0.5 0z. / 15 ml).

&P Enter a button title, then edit the power setting for the PRE BLEND segment.
Next, edit time, ramp and power settings for blending segments A-D (it is not
necessary to use all available segments).

&P Select a final programming operation.
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Programmer Window
Blending Station® MP and Touch and Go® Blending Station®

[ e memamastaon P

Fle e Mokl

MMM”ITHEBESTAU
ﬂmalsmoomwsm

total program time |ENEENERN

Whin finished select
® ok of e fallawing

STATUS  CONNECTED - Moduls Connactad Filennme : dalnuh BLS Taisd Tene -0 seconds ;

Programming Steps

The Programmer Window for Blending Station MP and Touch and Go Blending
Station includes four simple programming steps:

&P Enter a program title to be displayed in the blender display window. The title
can be up to two lines, with up to 16 alphanumeric characters in each line.
See Program Window for example titles.

@D Click on a button to program (1-6). NOTE: button selections
correspond to Buttons on blender control panel.

&P Enter a button title, then edit time, ramp and power settings for
blending segments A-D (it is not necessary to use all available
segments). See Program Window for example button title.

&P Select a final programming operation.
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Programmer Window
Blending Station® Advance

FOODSERVICE

m fitke fins 1) [THE BEST \ B
fine 2) if_u,!-:)OTbuI: #|

©:2004 Vits 3 ® Corporation
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Programming Steps

The Programmer Window for the Blending Station Advance includes four simple
programming steps:

&P Enter aprogram title to be displayed in the blender display window. The title
can be up to two lines, with up to 16 alphanumeric characters in each line.
See Program Window for example titles.

&P Select aprogram recipe (1-34) to customize. NOTE: there are 34 programs
(recipes) to choose from but only 6 buttons on the blender control panel to
program at one time.

&P Edit time, ramp and power settings for blending segments A-D (it is not
necessary to use all available segments). Continue programming up to 6 buttons.

&P Select Button Assignments & St s o aepogo e e
Button Names to enter button
tittes. Then select either
Program Module or Program
Blender as a final program-
ming operation. To Save or
Print the program, go to the
File Menu.
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Programmer Window
BarBoss® / Drink Machine Advance

& Vita-Nix.
FDHDEENVIEFf MMIJ’W
MR?ISMDOTHIE #1

or each segment button title [EGUEEEL|

total program time | JEEED
'When finished select §
. ®  ong of the following.
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Programming Steps
The Programmer Window for the BarBoss Advance and Drink Machine Advance
includes four simple programming steps:

&P Enter aprogram title. The title can be up to two lines, with up to 16 alphanumeric
characters in each line. See Program Window for example titles.

@P Click on a button to program (1-6). NOTE: button selections correspond to
the dial settings on the blender control panels.

&P Enter a button title, then edit time, ramp and power settings for blending
segments A-D (it is not necessary to use all available segments). See
Program Window for example button title.

€P Select a final programming operation.
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Programmer Window
Mix’n Machine™ Advance

l Vitﬂﬂil Salact the desirad Titte for the program,

rooosenv::r1 MMHW
mz)lnnasslm #1

fotal program time m

@ 2004 Vita-Mix® Corparation
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When finished seiect
W ong of the followng,

Programming Steps

The Programmer Window for the Mix'n Machine Advance includes four simple

programming steps:

&P Enter aprogram title. The title can be up to two lines, with up to 16 alphanumeric
characters in each line. See Program Window for example titles.

&P Click on a button to program (1-6). NOTE: button selections correspond to
the dial settings on the machine’s control panel.

&P Enter a button title, then edit time, ramp and power settings for blending
segments A-D (it is not necessary to use all available segments). See
Program Window for example button title.

€D Select a final programming operation.
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Programmer Window
File Menu

8 vita-Mix - PBS -
File Yiew Module Help

Mew

Open

Save

Save fs

Load Defaults
Prink

Prink Properites
Exit

The File Menu is similar in all versions of the Programmer Window and provides
access to the following:

New: select to create a new program file

Open: select to open an existing program file

Save As: select to name and save a new program file
Save: select to save changes to an existing program file
Load Defaults: select to load default program settings
Print: select to print a graphic summary of a program cycle
Print Properties: select to open the Page Setup dialog box
Exit: select to exit the program

View Menu
(for complete details about using the options in the View Menu, see pages 21)

8 vita-Mix - PBS -

File | Wiew Module Help

Edit Order
Summary OF Cycles

The View Menu is similar in all versions of the Programmer Window and provides
access to the following:

Edit Order: select to access the Program Order Window
Summary of Cycles: select to view graphic representations of programs

14 © Vita-Mix Corporation — Getting to Know the Program



Programmer Window
Module Menu
(for complete details about using the options in the Module Menu, see pages 22-24)

8 ita-Mix - PBS -
File View | Module Help

Program Module

Proaram Blender

Load From Programmer
Load From External Module
Erase Module

The Module Menu is similar in all versions of the Programmer Window and
provides access to the following:

Program Module: select to program the module (default)
Program Blender: select to program a blender

Load from Programmer: select to download programs from a blender to the host
computer

Load from External Module: select to download programs from a Programmer
Chip to the host computer

Program External Module: select to program a Programmer Chip
Erase Module: select to erase a Programmer Chip

Help Menu

Fle View Module [?!p
% Programmer Manual
s Programmer Updates
' About Programmer

The Help Menu is similar in all versions of the Programmer Window and provides
access to the following:

Programmer Manual: select for a PDF of the P i |
manual Vita-Mix Custom Programemer
Version 200 BETA
Programmer Updates: select to go to Vita-Mix Vita-Mix Corp, & 2004
website for programmer updates and most Contact us for questions or comments at
current manual 1-6004DRINKA (1-800-437-4654)
Itip-iwww vitamix comfoodservice/

About Programmer: select to view information
about the software

=
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Programmer Window
Status Bar

Fle View Modue Hep

BViteHi o sl
o2 [sMOOTHE #1

Select the desired amount of e and water ica portion|>
to dispense. (0min. - 70 units mak. ) water portion[n

total program time -

5 When find
& one of thi
Vitahtix Corp. © 2004

[ 5TATUS ‘Madule Connected ! Filename : defuh PBS Totai Tima 0 secon_:|

Status Bar

The Status Bar is the same in all versions of the Programmer Window
and provides the following information:

STATUS: indicates whether or not a Programmer Module is connected
Filename: the name of the Program File that is currently displayed
Total Time: the combined total of all segment times (SEGMENTS A-D)
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How to Program a Blender

1. Connect the Vita-Mix® Programmer Module to the host computer
(see Appendix B: Working with the Programmer Module for complete
instructions).

2. Connect the Vita-Mix® Programmer Module to the programming port of the
blender to be programmed, or insert a Programmer Chip into the Programmer
Module (see Appendix B: Working with the Programmer Module for
complete instructions).

3. Open Vita-Mix® Custom Blending Software and select the appropriate blender.

4. |fthe Programmer Module is properly connected and configured, the Vita-Mix
Programmer window will be displayed:

STATUS : Madule Cannecied

5. Text-enter titles in the program title fields (line 1) and (line 2).

6. Click on the button to be programmed. The button will be highlighted in blue
when selected. For the Blending Station® Advance, scroll to the program
button to be programmed.

If programming Vita-Mix® Portion Blending Systems®and the With Water
Support option IS NOT selected, proceed to Step 7.

If programming Vita-Mix® Portion Blending Systems® and the With Water
Support option IS selected, skip to Step 8.

If programming Vita-Mix® Blending Stations; skip to Step 9.
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How to Program a Blender o

7.

If programming a Vita-Mix° PBS Portion Blending System or a PBS Advance
and the With Water Support option IS NOT selected, enter the desired ice
portion (in ounces).

v Select the desired amount of ice and water ice portion|s

to dispense. (0 min. - 70 units max.)

If programming a Vita-Mix* PBS Portion Blending System® and the With
Water Support option IS selected, the following options will be available:

Select the desired amount of ice and water fce portionls ' =
to dispense. (0 min. - 70 units max.) water portion|n 0B

As you will see, there are four available fields — two for ice portion and two
for water portion. This is because PBS Units with built-in water dispenser
are equipped with a secondary program bank®.

Enter ice and water portions as follows:

- Enter the desired ice portion for the primary program bank in
the left ice portion column.

- Enter the desired ice portion for the secondary program bank
in the right ice portion column (SHIFT column).

- Enter the desired water portion for the primary program bank
in the left water portion column.

- Enter the desired water portion for the primary program bank
in the right water portion column (SHIFT column).

*NOTE: the secondary program bank is accessed by pressing the
Shift Button and then the desired Program Button (1, 2, 3, 4, A, B)
on the PBS Control Panel.

Shift Button
_~ Program Buttons

18
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How to Program a Blender coin.q
9. Enter a button title in the button title field.

slider handles ramp speed segments

If programming Vita-Mix® Blending Stations; skip to Step 11.
10. Edit the power setting for the PRE BLEND segment, using either of the

following methods:
a) enter a numeric value in the power field.

b) click on the gray handle in the slider field and hold the left mouse button
down while moving the slider up or down with the mouse.

. Edit time, ramp and power settings for blending segments A-D.

NOTE: It is not necessary to use all available segments.
Perform the following steps for each segment to be programmed:

- Enter the segment time (seconds) in the segment time field.
NOTE: the combined total of all segment times (SEGMENTS
A-D) will be displayed in the total program time field.

- Set the ramp speed by clicking on the desired ramp speed segment or by
moving the slider handle with the mouse.
- Edit the power setting for the segment, via any of the following:

a) enter a numeric value in the power field.

b) click on the gray handle in the slider field and hold the left mouse
button down while moving the slider up or down with the mouse.

¢) click on the desired value in the slider field.

12. Repeat Steps 6-11 for each button to be programmed.
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How to Program a Blender coines)

13.

Select one of the following options:

When finished select g

(For Blending Station Advance options, see pg. 11)

- program module

- program blender

- save

- print

To Program a Module:

a) Insert a Programmer Chip into the Programmer Module (see Appendix B:
Working with the Programmer Module for details).

b) Click on the program module button*.

c) Enter the number of modules to program, then click OK.

gy atrrng Meodkes =f

Hirer sy modiulis weold you e o
program?

—_—
i o I Carcel
d) The following dialog boxes will displayed.

BT PR A e ke Al ai;
Programming Module Checking Maduls Medule Pragram Verified

| [ 1] [ 1] HEREEREHEEEEERR
JC | JRE| =]

e) If programming more than one Programmer Chip, remove the newly
programmed chip from the Programmer Module and insert the next chip.
Step d) will repeat for each chip to be programmed.

f) To use a programmed chip to program a blender, see Appendix C:
Programming a Blender with a Programmer Chip.

* NOTE: Modules can also be programmed by selecting
Program External Module from the Module Menu.

20
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How to Program a Blender coin.

14. There are several other functions not shown in the main section of the
Programmer Window, which are available in the View and Module Menus:

In the View Menu

8 vita-Mix - PBS -

File | Wiew Module Help
Edit Order
Summary OF Cycles

To Edit Program Order:
Select Edit Order to open the Program Order window, which allows you to
assign saved programs to new button positions.

=100 x| 101 x|

[N \ Program 5 |
\ number o= e |

Left column

To edit program assignments, select the desired program, and click on the
UP or DOWN buttons to move the selected program as desired. Each click
on the UP or DOWN buttons moves the program one by position. Click on
the CLOSE button when finished.

NOTES:

Blending Stations®

Numbers 1-6 in the left column correspond to Buttons 1-6 on the blender
control panel.

Portion Blending Systems®

Numbers 1-4 in the left column correspond to Buttons 1-4 on the blender
control panel. Numbers 5 and 6 correspond to Buttons A and B on the
blender control panel, respectively.
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How to Program a Blender coin.e
In the Module Menu

[ vita-Mix - PBS -

File  Wiew ‘ Madule  Help

Program Module

Program Blender

| Load From Programmer
Load From External Module
Erase Maodule

To Program a Blender: see page 23.

To Load from a Programmer:

a) Insert the Programmer Module firmly into the blender Programmer Port.
The words, THIS SIDE FACING TO THE FRONT OF THE
MACHINE must be facing you. NOTE: Reference the product Owner’s
Manual for the exact location of the Programmer Port.

b) Select Load from Programmer.

c) The following dialog box will displayed.

T
Laading From Programmar

d) Remove the Programmer Module from the Programmer Port.

To Load from an External Module:

a) Insert a Programmer Chip firmly into the Programmer Module (see
Appendix C: Programming a Blender with a Programmer Chip for
detalils).

b) Select Load from External Module.
c) The following dialog box will displayed.

M-
Loading From Modube

d) Remove the Programmer Chip from the Programmer Module. NOTE:
Store the chip in its original packaging when not in use.

22
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How to Program a Blender coin.
To Program a Blender:
Plug a chip into the blender (see Appendix C: Programming a Blender
with a Programmer Chip for details).
OR
Insert the Programmer Module into the blender Programmer Port (see
Appendix B: Working with the Programmer Module for location).

a)The DISPLAY WINDOW on blenders with digital displays will read NEW
MODULE.

b)Click on the program blender button* in the Programmer Window.
c) The following dialog boxes will displayed on blenders with digital displays.

— ainil — ainil — ainil

Programming Blnrder Chacking Blendar Blender Program Varified
| [] [ 11] ERERNRNRERERENI
i | Ee=]

d)Within 10 seconds, the DISPLAY will read SAVED, then READY.
e)Remove the Programmer Module from the Programmer Port.

If the preceding does not work, then reset the blender buttons to original
factory settings.

WARNING: resetting will erase any custom programs saved in the
blender memory. To save programs before resetting, see To Load from a
Programmer, page 22.

For Vita-Mix blenders with digital displays:

a) Press the Shift Button on the blender control panel to
access OWNER CONTROLS.

b) When the the display reads MODE:

On Vita-Mix° PBS Portion Blending Systems®, press PRE-SET
Button 1, then PRE-SET Button B.

On Vita-Mix Blending Stations®, press PRE-SET button 1, then PRE-
SET button 6.

c) Next, access the instructions for resetting the PRE-SET buttons:

On Vita-Mix PBS Portion Blending Systems, press the Shift Button
three times.

On Vita-Mix Blending Stations, press the Shift Button twice.

(continued on next page)
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How to Program a Blender e

d) Finally, press and hold the #4 Button until the DISPLAY WINDOW
reads RESTORING PLEASE WAIT.

e) The PRE-SET buttons are now reset to the original factory settings.
For Vita-Mix blenders with no digital displays:
a) Turn the power to the machine OFF using the ON/OFF switch.

b) Hold down the PULSE button while turning the power back on using
the ON/OFF switch.

c) The pre-set programs are now reset to the original factory settings.

*NOTE: Blenders can also be programmed by selecting Program
Blender from the Module Menu.

To Erase a Module:

a) Insert a Programmer Chip into the Programmer Module (see Appendix
B: Working with the Programmer Module for details).

b) Select Erase Module.
c) The following dialog box will displayed.

TR aloisl
Veritying Erase

d) Remove the Programmer Module from the blender Programmer Port.
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Saving Blending Programs

To Save a Program File:
a) Click on the save file button*.
b) The standard Windows Save File dialog box will open:

2l
Savein [l Vieais Pragrammer x| BB

2 default

Cancel

File name: [example =~ Save
j = |

Save 55 type: [PES files (=PBS)

c) Enter a file name and select a destination for the file as you would when
saving a file in any normal Windows program.

Program files are saved as follows:

Vita-Mix® PBS Portion Blending Systems®save programs as *.PBS files.

Vita-Mix Blending Station® MP and Touch and Go® save programs as
*BLS files.

Vita-Mix Blending Station Advance saves programs as *.BLA files.

Vita-Mix BarBoss® Advance and Drink Machine Advance save programs
as *.BBA files.

Vita-Mix Mix'n Machine™ Advance saves programs as *.MMA files.

*NOTES:

Files can also be saved using Save and Save As options in the File
Menu.

Saved program files can be distributed via e-mail or on digital media
such as CD-ROM, floppy disk, etc.
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Printing/Viewing Blending Programs

To Print a File:

Files printed by the program are graphic representations of
program cycles, which are called Cycle Summaries.

a) Click on the print file button™.

b) The Print preview window will displayed:

c)Select from among the standard Windows print options

available in the menu bar:

% click to print the preview

ﬁ click to enlarge the preview

*NOTE: Print preview
can also be accessed
via the Print command
in the File Menu.

click on the desired layout icon
E n m to configure the page layout

Cloze click to close the Print preview window

1= use the scroll-edit menu to
F'agE = | select a page to view/print
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Printing/Viewing Blending Programs
In the View Menu
File | View Module Help

Edit Order
Summary OF Cycles

To View and/or Print Summary of Cycles:
Select Summary of Cycles to view graphs of saved programs.

LT =lojx
Cycle Summary Page Park Al |
Cycle Name : [Default 1 Font 1 =

= 0rs
z
&
o
£ —

) Ji

o'f g

Time (5] ¥ ¥
Cycle Name : [Default 2 Pt 2
F 3 [l
2
&
4
- /
_
-/
.frr
—_——

wle

Cycle Summaries can be printed individually or all at once.
- Click on Print All to print all cycle summaries at once.
- Click on Print 1, Print 2, etc., to print summaries individually.

- Click on the close box (]) to close the window.
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Appendix A:
Installing the Software

Before installing Vita-Mix® Custom Blending Software, please refer to
system requirements on page 4.

1. Insert the Vita-Mix® Custom Blending Software disk into the CD-ROM
drive of the host computer and open SETUP.EXE.

2. When the following dialog box opens, click OK to continue, or
Cancel to discontinue the installation.

Yitamix Programmer Setup ! il

=
@ To stark Vitamiz Programmer Setup, click O, To guit without installing, dick Cancel,

3. The following messages will be displayed as the setup takes place.

Setup is working, 4] Preparing to install
This may take several minutes. .

Cancel

4. When the Setup Wizard opens, click Next to continue, or Cancel
to discontinue the installation.

izl

‘Welcome to the VitaMix Programmer Setup Wizard%
it

The inatalier will guide you thiough the steps requined to install Vit Programmes on pour
corgade.

WARNING: TH psiy wighi L
wihized duck cistabution of thiz program, o s poeion o it. i A

e T
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5. The Select Installation Folder dialog box will open.

Select Installation Folder

T i Programimer 1o thi

To mated in thir febdes, chick "Mewt™. To install to & diferent Iokder, entet it bekow o chick Toomse',

ok
|L'.\Hwoul}'bl'\‘r'llﬂhlx‘.\fﬁﬂv Programmer, Bpomasn
[isk Cost
Install VitaMu Fro h ol o o s curmpute
T Ewesone
i~ Jutme
e |t |

- To install the software in a location other than the Program
Files folder (this is the recommended location), click the
Browse button to browse to an alternate folder.

- Click on Disk Cost if you wish to view information about disk
space required by the application.

- Determine who will be allowed to use the program by selecting
Everyone or Just me.

- Click Next to continue the installation.

6. Click Next to confirm the installation.

Confirm Installation

T i eady o i o P1ogIBmar 66 your complter.

Chck "Ment" to start the inttalistion,

o Lo ==
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7. Wait while the program is installed.

19 2t Brogramemer o=
Installing VitaMix Programmer %
.
Vitait Progiassenat i being indtaled

Flease wst .

8. Click Close to exit the Setup Wizard.

L5 P SEE

Installation Complete %

Chek "Close™ 10 et

k NET Frammssk.

9. Click OK and restart the computer.

Yitamix Programmer 5 5[

Setup succeeded.
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Appendix B:
Working with the Programmer Module

Connecting the Programmer Module to a Computer
The Programmer Module can be connected to a computer in either of two ways:

1. Plug the USB connector of a standard USB Cable into the input on the
Programmer Module, then plug the USB Cable into the USB port on the host
computer.

Connecting the Programmer Module to a Blender

Insert the Programmer Chip firmly into the blender Programmer
Port. The words, THIS SIDE FACING TO THE FRONT OF THE
MACHINE (located on the top side of the Programmer Insert
Section) must be facing you. NOTE: Reference the product
Owner’s Manual for the exact location of the Programmer Port.

Inserting a Programmer Chip into the Programmer Module

Insert the Programmer Chip firmly into the Programmer Module
as follows: With the USB port facing to the right (as shown) the
words, THIS SIDE FACING TO THE FRONT OF THE MACHINE
(printed on the the Programmer Chip) must be facing you.

Programmer Chip -

Imprints:
THIS SIDE FACING

TO THE FRONT OF
THE MACHINE

To blender

USB port

Programmer Module
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Appendix C:
Programming a Blender with a
Programmer Chip

Insert the Programmer Chip firmly into the
blender Programmer Port. The words, THIS SIDE
FACING TO THE FRONT OF THE MACHINE
must be facing you. NOTE: Reference the product
Owner’s Manual for the exact location of the
Programmer Port.

a) The DISPLAY WINDOW on blenders with
digital displays will read NEW MODULE.

b) Within 10 seconds, the DISPLAY WINDOW
on blenders with digital displays will read
SAVED, then READY. If this does not
happen, remove the chip, turn it over over,
and try again. If the problem persists, try re-
setting the blender controls a second time.

c) Remove the Programmer Chip from the
Programmer Port and return it to the original packaging.

If the preceding does not work, reset the blender buttons to orginal factory settings.

WARNING: resetting will erase any custom programs saved in the blender memory.

To save programs before resetting, see To Load from a Programmer, page 22.
For Vita-Mix blenders with digital displays:

a) Press the Shift Button on the blender control panel to
access OWNER CONTROLS.

b) When the the display reads MODE:

On Vita-Mix° PBS Portion Blending Systems®, press PRE-SET
Button 1, then PRE-SET Button B.

On Vita-Mix Blending Stations®, press PRE-SET button 1, then PRE-
SET button 6.

c) Next, access the instructions for resetting the PRE-SET buttons:

On Vita-Mix PBS Portion Blending Systems, press the Shift Button
three times.

On Vita-Mix Blending Stations, press the Shift Button twice.

d) Finally, press and hold the #4 Button until the DISPLAY WINDOW
reads RESTORING PLEASE WAIT.
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e) The PRE-SET buttons are now reset to the original factory settings.
For Vita-Mix blenders with no digital displays:
a) Turn the power to the machine using the ON/OFF switch.

b) Hold down the PULSE button while turning the power back on using
the ON/OFF switch.

c) The pre-set programs are now reset to the original factory settings.
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